YsRML-R ; HISsAse Asucl Wauls st

YUrcllcell

2.1, 32l (Data) €lWA $A AR Ao SHELDL (Formatting) 59

2.2.  AldoL (saving)

2.3. [Q(aL (Printing)

2.4. Sl Al 520t (Formula and Functions)ell HEEL QAAL s2cll
2.5, abelle, A, SlAM A AA (Worksheet, row and Column) AU s1H 5
2.6. 2w g2 (Table Format)

2.7. AL (Sorting)

2.8. (3R (Filter)

2.9. Rt

Gzal

UL AsUoll oA sl GLE AR

o AsAA-2010H1 HIRA el 53 asl dal Aol olsarl 53 sl AMx Aqf SHEloL
(Formating) 53| 2590 ol cdyls wal adlled sleletd AUt url 531 asql.

o AsAA-2010 cbofsal WAL WAL SHNeHl (Format) Ack AH Doz 531 asell.

o el el UslRell oalddl 58 A scll Amer »sUl ual AssU ARLAZNRA scl [AlAY §52lotall
Gualat 3cl A sl A A1y sl

o HIBEAA GRdll, uadl ¥ Sl Wssu sHHL ool A5 Ay Wolloll HEAlA weol wsl
A5 A g YO Ml clollst 531 aAsal daul uctal dlecunt et AsAAHL vl eidl
sl

2.1 32l €A 5l Aa Ao sHElaL

AsAc aboisui adalle waAdl sa & ¥ Adell cacll 8. slsurl AdHL Yuaud 2R YslRell del
el 531 aslaA 8. 1) s 2) ARl AR 3) Sl

32l ElHUA $A

32l ELHUA $al HI2
1. % A Ad HIGH WSoe? Aucdl AR sl RQAse s
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2. 32l asu 83
3. W2 Ul AR §l ectdl

AsAA dlRlH Aol YHAA s dld AUR B, AsAAHL 1-910(31-190001 oleisUis 1 8, 2-
1o AI3] 19000l ololR sUis 2 B A%y A el AR 1-81ey21131-19008l Aol sH YHIQA oleiR
dAA 8. UsA AU d¥ @R sl ARl U Al udcusdl s3Il asta B eld. A
AR Rt (Bl et Aol ciecttsl 531 asia .

32LHL ¥R81R sl

Usal? del el salloite AHl %512 urll A aug Ad B BH %,
o 32l dldle s3la

o d2lal o 32l aAd weclal

o AssAU 32U 3R81R s3lal

ActHiedl et slclle sal M2 As wadl s 5l durR Ada RAse 3l Slddle $l eotcllal g2 53l
AslA B. As 5cll dUlR AA (Range) o RAAs2 sl shift+Arrow Sl wdcll HIGU J9U (HIGU<] SLYj
oot eollcllal AA UR ¥Radl)s? RAse 53l asia B.

32 Sllle sRal sl 4.1 el YHIA Home Editing = Clear RAS2 $cll dHal Ui [Ascu HAL
& Boll Heedl Acuiel 3at ual SR, 1A fle, vt 32, s1Aee, 3 slauAds g2 53l asta B.

@HEH9-e-0 L Bookl - Microsoft Excel - o EH

“. Haome | Insert  Fage layout Fomulas Dats Beview View  Acobat  Team a@od
t:' *("' Calibri BETEII S -m - | EFwipTet General - EE ﬁ 1_@ E" §‘ :Ej E Autasus - ‘:‘ET |ﬂ
P et B 7 Ut 0 O Ac EE W R Enewacmes §- % v 38 Lntom fome o men o form | jana et
Cliptioard % Font [ Alignment n Number 2 Styles Cells 2 Cegran |

Al - (= 5~ ¥ Cleas Formats L 1|

A [ 8 | ¢ [ o | & | & | & | w [ v ] s [ v ] v ] wm]nT]]oT & | Cless Contents T~
S — owcommens |
2] Clear yperjiniks |

j 5 Bemovedypeninks | |

(A 4.11 QM 2ol wAA BAURSHLS (Clear Command)

AAHL AAA 32lal U 32l dd sledal A AAs2 53] olcl dal 2lsU 5l ol 32l olall dal ad
olecdld 8.

Actoll 818 AlssA S2ll 38R scll (edit mode) AsAA (1A Yoyololl [Ascu A B.
o Ad WR sucd (5As s3lal

CCC-BAOU and CCC+ 12



e Ad RAs2 53 F2 8l Yt 53 waal
o Ad RAs2 5cl Aoll dal SLJAllRML EwlA B Ul FJAlURHL 3812 5l AcHL 38R
ad B, (sl 4.12)

@905 Bookl - Microsoft Excel - o IEH
“ Home | inet  Pagelayout  Fomuls  Daly  Redew  View  Aaobat  Team a@od B
[ja sz:;- Calitri e A AT oo | B | SRwrepTed General - E‘_u’!l _./" / j” “:J*- [Ej ;:“"‘_’s"""' ?r ﬁa
Paste o Farmst punter BSOS A EF W PP GrMegeadenters | $ - % v | %3 Il:narr:”-._:::c.\.. ‘:c.:r.—m\; SI?I(H' Inigrt Delete Formt & Ciear = ::II:'Q' ::Ilfﬂa:'
Clipboard s Font T Alignm ent = Humber " Styles Cells Egting
[ 83 = (= % v £ 5l cucuidor wids sz wluet yFquldl
Al A | 8 [ e T o [ € I ¢ [ 6 | w | o« | o [ & [ v [ »m [ w ] ol » ] a
1 4
2
3 [t sucnzndor wids 52 wlud yEaalEl |
4 4
s 4

gl 4.12 Actott et fudetiouRe(l Heedl sead

wl(gctell Heedl det ARy elud sl

AR WUGL 32l sHHL vadl sl BUF 1, 2, 3, ..10. WUl Sunday, Monday...Saturday WU
January, February...December W&dl 01-Mar-2014 &l 31-Mar-2014 AR U WU AsAAel
W5 ([Ascusll Gualol 531 astal B, 3l GURAd U AlssU sH Yool Ul det (3at 531 aslA
gla. A2 (3ctall Gualol sl us(Aui-4.13 L 2llcaut YAl 2A3uldoll Bud 2l Feet Acl (3ad
5cllo] 8l dzcll Ad RAAs2 5A RURGUE Home =Editing =Fill UME 5cll sl 4.14H1 olcical
YHIAle] SIAGAL sllsy 3 Ust Al 8.

EE9-o-0 g Bookl = Microsoft Excel - s IEN
“ Home | Inset  Pagelayout  Fomulas  Dats  Redew  View  Acobat  Team a@os
= K Cut - = }j Sper = =, = EE  E suteSum - i
3 Catinri - - = * | &R wrap Text General - E ﬁ g | - j\ - ﬁ
0 gy copy - A - W S5 wrap i 15 =l _!_I s ZT
Faste = .| g - IEEE | S Merge & Center - AR, Congtignal Feamat el Insert Delete Format | - - e s
= off Format Painter LA = A B E W GREF G meges cente SE W 3 Formatting = as Table = Styles = - - = @ oown

Cliphoard 3 Font 5 Alignment 0 Humber 5 Shles Cells

IR AE 8 w | -

A B C 8] E F G H I J K L M N =] P Bl et | T (=
1 Linaar Waik M
2 1 geries...
% B e sener
5
Ll
il
8
3
10

Al 4.13 32t (3et s
Series In: %l dHR U (et 529 8lal Al rows URLE $A walall 2l 4.13 Y Glef (3t 524 8l
l columns UE $3A.
Type: sHMl (3 529 &l Al Linear, dllw (3ct sAdcll U2 date UAE $A. JJRUSIR $Rcll Growth
ude s
Date Unit: %\ typeHi date 8 Al% dectl [Ascu Hadl.
Step Value: 233lclofl (BHAML 32 dtlll U A £20A B %R stop valued Bi[AH (BHd g2l B.
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- I

Series
Series in Type Date unit
E:J Rows E§l Linear % Day
(® Columns () Growth Weekday
) Date Month
() AutoFil Year
[] Trend
Step value: Stop value:
==

gl 4.14 Get A2 staclol dllsu

ol Il A3vllctoll As vl A BEud AcHl dvll Ad RAse scdl Aoll wHRll ciy A HGH
Aulcl Wcoll aRatouell (+) Aauell Buwd B B (3t 305 58 B Foll UR HIGH AVl FoU s

AsAA AUAA (BHct Yosol dQauu ugdloll B el

A3l youl ustAl

0.

1. ollAcll 2uslQui (AU ysRell 32t Fill AU B A dA oA AsAAML (3t Aol neeall

e s2clloll Yaleol 53

BEd9-~-D0egis
“ Home Insert Page Layout Formulas Data Revew View

j “"Cu‘ Calibri S A AT ] B

<4 Copy *
P‘.‘“ J Format Panter BIU- L &-A- EER EF
Clipboard . Font Alignme
[ 116 - fe
A B C D | E F G

1| (et 01

2 Llinear-1 Llinear-2 Growth Days Date Time b
3 1 100 5 Sunday 01-01-14 1:00

4 2 95 20 Monday 02-01-14 1:30

5 3 90 80 Tuesday 03-01-14 2:00

6 4 &5 320Nednesda 04.01-14 2:30

7 5 80 1280 Thursday 05-01-14 3:00

8 6 75 5120 Friday 06-01-14 3:30

9 7 70 20480 Saturday 07-01-14 4:00

10 8 65 81920 Sunday 08.01-14 4:30

11 9 60 327680 Monday 0%-01-14 5:00

12 10 55 1310720 Tuesday 10-01-14 5:30

13

-
2

AUl 4.15 (3et A% Gelswl
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e

AsAA delal el el el ¥R s:cloll YAul AW B, AsAA gL AUl seqf (A o1A

Yoo .
slile Gualla
(General) gallaal dura 8.

Sl612 (Number) {5 M2 duRpld B. ¥ecl s €2l Ra ugl eolaal B, dvaunl sxel %€l
galatal SlHL cllURA B ¥ L vl 56 A eallacl ® A HER @Qscu i B,

50l ol eallacl dupga BD. 3ecl s e Re udl eallaal ®, Avunl sostell

(Currency) o€l gallclall Sl cluRAl B, 53 okl Re alurg 8, »al Aval s8¢ a ealadl
8 A HRell [@Aseu W B.

32 (Date) el el A dAflua eallaal {2 auvAA 8.

2lSH (Time) el gel A AN elaal HIRZ auvAA B.

2sl % Ra Auer 3eal vis aial Qe ugdl wUad A gl B.

(Percentage)

$52lot el el 9 3l wuyalisa ealcll asia .

(Fraction)

A3 sl Ulc 30 £20A B. El.cl. 205,000 A 2.05E+05 dd g2lcua &,

Scientific

252 (Text) Sz Hl WA visal ULl AWl d3l3 2 B.
A e atlRle{l dler sz eallad B.
(Special)

s:2H (Custom) HIZL Wdlell Sz B ol 51¢ sllenl o dlal A cauvuRd 53l sl €.

20A 4.4 doR slile

Ratatoll Heedl sl s1El0L 5

UlA 4.16 1L g2lcaul YMIEA Home & Number YU dHal olei? S1ile auclloll YAul WA B. ® A
@scu UR MGA W2 Al Aoi@ &8l uHgAl ol .
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osl eolacl  AsAUE dulal

Generai l -
@, Vo .0 .00

{00 =

T Numbe I

Elert bl AlsAULS ualscl
sloRal slHi ol el eallaal

(A 4.16 M 2ol A ook YU

gile slacllol dlsuell ueedll slie s:q

slile staclol dllsuell Heedll ual sUTETaL 531 atstal &, Sz stAAL ollsU vl Sl el Aldd
ool Yurl wHEl cltey ollA wWAA ceol UR (A5 sl 2s(A 4.17 Ysololl e slacdlol s WA
8 gul Lol W2ell Qscu wWad B.

| Font IEorder I Fill IProtection

Text alignment Orientation

Horizontal:

|General

Vertical:
| Bottom
Justify distributed

Text contral .

[] Wrap text gegrees

[ shrink to fit

[ Merge cells
Right-to-eft

Text direction:

oo [

gl 4.17 Aile slacldL cllsy

2see sLldla
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gl 4181 gl Y 2see QDL scl W2 Home D Fontyu UR 2se Sl wi2all
@Qscu wWAdl B Bl ¥ floz Aol doll WEH alecdl, dlles, Bell@ds, WosAAES, 18R, Hloz SR

ARl W yalscll, Aol Slo SAR HEAD AHY AAHL SHR MR

Formulas Dal

Insert Page Layout

Home
iy
Cut PR
& Cu Calibri 11 AN A
.

— 53 Copy ~ i A
aste - N - -
- - Format Painter B I 10 = Sl

Clipboard (P Font I

AUlg(d 4.18 AM 26l UR WAA o2 YU

ay [@Qscu w2 floz Yui wHRll ciy olA WA oleet eulleldl uislA 4.19 Yosololl Sl st

s WA B il ay [@Ascu U .

| Border | Fill |Prntection |

| Mumber | Alignment |}

Font: Font style:

Regular

Calibri
eadings

Cambria
Italic
T ADARSHN Eold
T Adline Bold Italic
B Adobe Arabic
B Adobe Caslon Pro

Underline:

Colar:

[v| || ] normal font

Prewview

|None
Effects
[ strikethrough
D Superscript
[ subscript

AaBbCcYyZz

This is a TrueType font. The same font will be used on both your printer and your screen,

ALl 4.19 Qe stACdL ollse] Slo2 261

sl 4.20 Ui ealcaul Y Home DAlignment YUHL 252oll Sl Ay Glell dNsclll (Alignment),
AAHL 252l WASAl (Indent), e5al 518 AssU SQL (Vi) UR ccllacll (Orientation), WS Scll
AR Adtal el Y€l A Adu/al scl (Merge & Center), A AW Actoll GlalR ot o2 A M2
oAl AUSAHL clalal (Wrap Text) Fall [Ascu wdcl sl .
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[ -ad Merge & Center| =
9 E:Wrap Text @" Angle Counterclockwise I g
. %

Angle Clockwise [ : Merge & Center

1l
l
IR
%

= = 5 3= | & Merge & Center ~ -
’ - lﬂ Vertical Text 1 Merge Across
Alignment —J |4l Rotate Text Up

|& Rotate Text Down

-@;" Format Cell Alignment

ALg(A 4.20 U 201 UR AN AASeiNo YU ual dell [Ascu

A SoiNoe Yuul wHQll ety ollA WA weot el gl 4.21 Y@l AetlSelNoz SIAADL
st WA B, Bl At sl selloll dy [@Qscu 1A B.

| Font | Border | Fill |Protech'on

Text alignment QOrientation

Horizontal:

| General

Vertical:

|Eotton1

Justify distributed

Text control

S 0 e

[] Merge cells

Right-todeft
Text direction:

A 4.21 Qe At SIAAWLL cllsUo] AN 20l
il yauld ustAl

1. dX UG (3t s Alloell €35 SlAAMA WAL 252 5ER Ul (A 5EAR W,
Sl A ol 32l A 3{luct WeSo 2.

SlAM B oll 32lal AsIGo2lol Rclled

SlAM 3310 ofl 2524l 45° Aot UL

> owon
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2.2 AldaL (saving)

AscllR AsAA abolle dAR U xsa ARMUE Al Ad salell A stad MR 6l (38 UR sl
13U RR UL sl B YUl 53 A SFA %32 USA Wl U A Al AHY AHL $$12 531
AslA, wAR N ASAA A A 5 B AR HNG A A dof WsRo2ot .xisx WA B U AsAA
dHal W S SlaHl uQl RAR sclloll YAul A B Buiell decdls yul@d sid s1xe ol ael
2old-4.540 lact B.

sl A scll wglQ 4.22u0 eallcall YHIQ AsRy Ui WAL Save ¥ Save As SHloSsll
GUAL UL © Botl UR (A scll gl 4.23 Hl galcaul Yu@oll A SIAADL clst WA & BH
St ol el Aol Slie U 512Ul 585 UM RAR scl B A wat 2l sl .

&I =

!i! Home Insert

lﬂ Save
B Save As

.= Open

,__f Close

AUlg(A 4.22 AsRy il Ad HRall [Aseu

L 3 v Libraries » Documents » AN v Search Documents y-]
Organize v New folder = - @
- A
|‘.n_—"| Microsoft Excel Name
) Add-in Express
[ Favorites | Adobe
4 Downloads . Adobe Captivate Cached Projects
1= Recent places J Any Video Converter
B Desktop J AVSAYOU
J CrashDump
- Libraries J Cyberlink
3 Documents . DVDFolder v
J’. Music v £ >
File name: | 19 v
Save as type: | Excel Workbook v
Authors:  HIMANSHU Tags: Addatag
[] Save Thumbnail
. Hide Folders Tools  ~ Cancel

AUlg(A 4.23 A sAAL ollsy
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slile UsASool  GURADL

Excel Workbook xlsx ASAA-2010 ol AsAA-2007 H2oll Yoo st sl @
XML AUR 8.

Macro Enable Excel .xlsm ASAA-2010 Wal WAsAA-2007 H2oll Sz B XML WURA &

Workbook A A8l sls uRL RAR 52 Y .

Excel-97 and Excel- .xIs AsAA-97 ol AsAA-2003HL Yl 2¥ Adl w3l g8

2003 Workbook slile.

Template xltx ASAA-2010 W ASAA-2007a 21A2 A3} R sall Hizoll
st slle.

XML Data xml XML sileul el Rkl Al B.

Text Axt wl SleHl AsAA 32l 2ol ¥ slHL ad el wsl UEL 252
Siledl ¥R 52 ® ¥ DOS, Machintosh, Linux AUR(EoL
Rreuul AUt a8 A3 B.

DBF 3, DBF 4 .dbf ddl AsAAML Al A 3luet 831 A8l Hl URd Aol L
ileui Ad el 53 sl

OpenDocument .ods Ul el Act YA 91T ol SlsgRoe ¥ W Uat (Ut

Spreadsheet CALC WM ddx dl Sl qWe s Acl el YIUHHL
WUl U A5 BD.

Portable Document .pdf wL Sz Au W yul@d B.

Format

Hyper Text Markup .html Sl Aol WSy A3F Acd scll AL e qurL 8.

Language

20ld-4.5 AAA s slile

2.3 MGt (Printing)

AsAA aboys Moz scll MR (A 42410 ealcal YU AsRy il WA Qo2 5MLosall GUAloL
Al B BUL A AglArl UHstcaul YHIdell [@Qscu Guaod alad 8. dX Qo2 5l Uddl A ¥q
gulldl A alseogell HRll oy A ws Ol Moe (Ascuni Al BeA Page Setup [As wAA Sl &
Boll UR (A5 scll wgld 4.24M0 eallcall Yool Uy AeuU SIUALL st WA B FHl UL,
H(%Fot, 852 ual g2 Axy le HR ay [Ascu 1A B. Moz vleet (A5 sl RAse sl Mo UR
WRLE sl [Aseu Yxololl Qo2 ollst ®.
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Asey il Moz scl UdAl HRll olly A 3 WA A A AslA B U AML 3812 831 Aslcl
Aell. %l dAHR WMoz 3q Tl A WA 2l ¥R812 sl Sla Al sl 4.25M0 ealcal Yol View >

Workbook Views = Page Layout View URE $cll A s tlal B.

[E|_,-‘""'[‘"|=

n Home Insert Fage Layout

|l save
[l save as

5 Open
[ Close

Bookl

Y CrystalReportViewer]
EJ 15354772541902nd3...
E] CrystalReportViewer]

Info

Recent

New

Save & Send

Help
2 Addns -
2] Options

k3 Exit

Bookl - Microsoft Excel

Formulag Data Review  Vie

Print

i
Hﬁ'l Copiess 1

Pint "%
Printer / ﬁlﬂa? HE Ea
J Hewlett-Packard HP Laser)...
e P ulsélel 2lle, wndl abogs
Printer Properties B oulsl ude secl eol

Settings ﬁ-lﬂ'a EQCD. Q?
_’_J Prnt Actrve Sheets =

Owmby prnt the sctree shests %aﬁu :ﬂ_ %a{-\u ﬂ% [:'10'3
Pages: - o - —

B2cl 87

BRS™.. ... - L _

g b G| (e 52q B2
j Partrait Onentation -ﬁ

ﬁcm.;;um e Uuz ofl 2efx ude 53l

Mormal Margins - - LAl e 53
i—] Left: 1.78cm Right: 1.78 .. —
) No Scaling . el afslle, sut Slew ¥

00 Print sheets at their actual 5., N
R eefl 2L 25 Uerul Auielal
Hiz wél a5 52l
R (Ctrl) -

set sedll «lsct
slacll & o e3d &
[z olzel

(A 4.24 Qo2 sUos(AsCU

Qo2 Al Ul dHR U Uil AUAL UsA A lal HR2 sl 4.25H0 clcdical YHIB View >
Workbook Views =» Page Break Viewsll GU2L0L 531 25l 6.
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Marmal

Page |Page Break @ Custom

Layout | Preview
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Views
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Full
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Page Setup ?

Margins | Header/Footer | Sheet

(®) Portrait () Landscape

Scaling

@ Adjustto: 100 5 % normal size

() Fit o 1 + page(s) wide by |1 + tall
Paper size: A4 b
Print guality: W

First page number: | Auto

Options...

(A 4.26 S A2U SLAALL cllsy

Adtdl woul ustAl

1. dR celldcll sl Ac 5A A Aoll pdf ST olatlal.
2. d olelldcll s185cej RoeuGe AL

2.4 91Jcll Aal §52lel (Formula and Functions) oll HEEYU QAL 52¢c(l

UG Rl Yool AsAAN Hualed GUAL QAR sl HIZ B, AsAAHT aballesl e
AAHL WA 5L 32l UR 2Ll sal S1dcl auRla B. SuRjcllall slauel A 8§ ¥ ¥ Actall
st Hi GuaAdL A 8l A Acdell (BHd Gl B R AsA WU Ul Sfcll ARl 8l
A Acdoll otcll Bud ML A B, 51Jcll Yy olA Yosololl desloll uacll sl .

1) oURAs Ast BA AU sdcllA B B ¥ +, -, *, /, %, °
2) AA AJU El.cl. Al
3) (U El.cl. 10 Ua

4) $o82al ELl.cl. sum(A1:A10)

slsul SlRjcloll A3l = Al aad B.o(A 2ud 4.6Ml declls slRjcllell GeleWL WAL B.
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=5%6 5 A 6 oll ARUSIR 82U

=A1+B1 Al 3ol Bl Ado(l SIHall ARl 83

=A173 A1 Actell Budoll 3 wuld s2¢ll

20ld 4.6 SLRJclell GELEREL

olAotl 20t 4.7H1 €20Acl U2 SURJAML Aol WILcAlsH Yool WAL B. AedA ¥ Sufclml
URQUOLUL BUR2R Slal RUR AL SHHL Ao HEUIsel UL B. Bl dAHR SE U0l MU AlsH HEA
Al Al Aol sludl cvll 28l 8l sl dlet Yo A YU yadail wWa 8.

yluze: GelgRWl  weEl AL cll
A Al "Bl ld 1
* Al x Bl JJRUsIR 2
/ Al /Bl GLOUSIR 2
+ Al + Bl ARaldl 3
- Al—B1  olestsl 3
& Al & A2 QA AWl slsall 4
= Al = Bl Al ol Bl AWl 8l dl ALY, olldcdR vllg 5
< Al < Bl Alell (Bud BT ofl (Bud scll 2| lat Al ALY, oAldcR viig 5
> Al > Bl Al oll BHd BT ofl BHd 52l ay &la Al W3, «lRddR Wig 5
<= A1 <= Bl Al ol (it Bl ofl BHd sl 20l ¥ 20l Sl A WY, oAldcR WE 5
>= A1 >= Bl Al oll (Buct Bl ofl BHd scdl Rl 3 ay 8lat Al WY, olldcdR V1§ 5
<> A1 <>B1 Aloll (Buc A (BHct Bloll GRAGR oll 8o Al ALY, olldcdR Vi@ 5

20l 4.7 Sl duRldl BluReell AL clsH

ELcl. (3 +5) /7 4+ 5" 3 -2 Yl oflA Yol G3cud

(3+5) / 457 3-2
8/4x%x5"3-2
8/ 4 %125 -2

2 %125 —2
250 - 2
248

CCC-BAOU and CCC+

WA YA

A yuH sl G3cdl 5 + 3 = 8 HA B.

RUGLE Ul B3l 2@ 5 ~ 3 = 125 HAOQ

8A / val * ol AUl wReR sl 7 yan dla Aol awddl ad
8/4=2, 8 * oll AdYcllsH Sl 2+125=250 U

RURULE GLEMIS] U UA vi[AH walol 248 U
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AA g Wl A 3%

Ad A YauMs AsH B Bl AN HRAL etrct 531 sl Ol A Aoll AJYU dd A2 B, Act AJA
A oloR U Sl U8Ry wadg 8l B, wAR WA WA As scdl ay A uR sudal @)
usclell @2l R A ol A RAs2 s2clloll %32 U B. Al Aol UYeA 3% 53 B.

Shift+Arrow $Slo{l el MUl AUl AA UR (A 53 UG J9U 5ctiAs 5l dy Ad RAse
Al B. el AUsA 4.27-aul RAs2 YAl Actoll 3% B2:E4 (Aol Acto] AJA : AU Actq]
AN O,

Ln[f e | pa |

us(d 4.27-a Act 3 B2:E4

wlsld 4.27-bHi €20Ad aboisell delal tallal Adl wwAell sAHLS Aual M2 sJall F4 A
Al usA daul Sudell = C4+D4+E4 UA SRQ 5 C4, D4 Bl E4 ofsA HISU-1, HSU-2 wal
H5U-3 8. Al At AJA R alsU 530 A5l Ol Al B Acto] AJYU A 8l Aol UR (A
scll A AJAU AUWAU 28U U 1 B, sleull Sl cdvwal w2

o R AUl wAUW ASA 8l Aal RAs2 5A

o = [Rauell aisu s .

o e asu sA

e Enter 8l oAl

dd sufattal siUl 531 28l 6l gl A crRalr durcll ot Ud. Ao (Aenel0ell st b ual 1R
F4 Ad RAse 531 (3t dosctell HIGU J9U 5l AsAA AUNMU Slfelt Ml W B.

Hisda Misd2 wsda ufeun

SCELM

o W e

w2l 56 96
H2d 65 66 55
Aclot 85 33 66
(ecllu 96 55 65
1¢0)oll 66 22 48

AUl 4.27-b el Gelerwl
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At 9 (Rleel) A UsRell Sl 8. 1) WAL (Relative) Aol 2) (A&l (Absolute) Huelct I Act
o AU A B, wAUR AN Actoll aisct 5A Ol AUl A 5A 6l AR, YA A Al SlAH
Aot RAEA 2R alecta B, eld. % dR ofly Auiell USEl AUl YA (=C4+D4+E4) oll otsct
5290, cll L YA 38R UL (=C5+D5+E5) vlofl %

(A0t Aeeloll Guallol 531 wauR dR Actoll aisct $A Gl AUl Sld 5A Ol RAUR UEALAL ol ual
AR (Bt aecaloll o fla @R duRla B, ERUet deel wudl HR Yol SeRel st ($)
AURLA B. 2HA 4.8H1 A AUcl/ua SIHH 58 I WssU/(3s 53] asta Aol Al WA B.

slijal el

$A$2 AR sudal SIUL 590 R A U SlAH olal slecld ol
A$2 R fall SIUl 5290 R A decld ollg
$A2 ol Sdetl SIUl 5220 R Sl Uecld «il@

20 4.8 NoARJ2 G

sl 4.27-c Hl en Aual Mol Scl €M = dotcdl * $E B BHL Uoldl Gleclldl olll wAR s€
declld © Adl ofly Aul en ualell SJcl C2 AUl =B2+$ES2 UN AUY Fld dosctell scl
SIUL 5cli C36{l S1fctl = B3x$ES2 A wH 58 Actell BHd Sdaumi seddll of sla R AssA
AA gRooll GUAL Ul B.

1
2 [AeyflHuy

3 deyilHay 58.39
a eyltay 46.95
5 ueylfan 29.98
6 dcyflHay 51.28

AULg(A 4.27-c AU A 2Re<] GELEW

%5910l

AsAAH YdeauvaulRd YA ($52e)ell ABAI B Boll dR Bsuell stal Al QAR sl Alet
A8 A8l BLAML UHWA s Bl ¥ ARAA, RUSIR, URAL, HETH, Ayt UL 4} B. AsAAM
2see SLHRoL, At 2526, olllislal €2 2R, s (AsAMEL cdR HIZ AsI| $52Uel WA B.
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ER85 $5otal Ao 3lA s scll MR AssU AlSURUAL (Syntax) B Bo] UAel ag KA. 51l
A §590t cluRall YUH = Asll, $5Aole] olld, ol Az /AAH|2R elvcd sl Ud B,
AUl Al HEA wuatdl A & Boll $520ta AQUAIL scUML %32 Ud B ¥U ¥ Ad
ool 3. WA slUMl AUl w33 B. €35 RN dd Acy WUl AA WA 3%
UUAHL WA D B BafsN < waall 7 &l el Ud B, sl 4.2841 SUM $s52atell sct HIs 585

AA cdual A ddlad B,

A ol ollY st ulFoun

Lse | ose | g7 =sumiEEEd
66 55 | SUM(number1, [number2], ...) |

65
Actol 85 33 66 | |
AUl 4.28 §seote] GELsWL

yl2lUH SHLeS

AcUl $52el ElMA scl HIR ws(A 4.29M0 galcal Yol Home = Ediing & Autosum SHloSoll
GuaaL 531 2ASA SlRAAARUH WURAR Actel 3 RAASe AR, URRAA AR HE2 RAse 52 B.
GURell GeleRRHL F4 At RAASse 531 Autosum SHloS £ollclctl ASAG WA §52et AVl A B @

AHR HL A B ¥ olld A x %lald] & B.

= AutoSum * S [ﬁ
7

| Fill
Sort & Find &
<2 Clear - Filter - Select =
Editing

(A 4.29 WAUH sULS

$59lol A3

sl 4.30u0 ealcaul Yud N Sudel 20 UR AAA §52let ABAIL Yusil Guotell oualisla,
ARSE, ABLRL, Sl A AHA Wl Al $520t ELWA 531 28 B
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m_HDITIE Insert Page Layout Formulas Data Review View
fi 3 @ #0080 @ @

Insert AutoSum Recently Financial Logical Text Date& Lookup &  Math More
Function - Used - - - - Time = Reference * & Trig * Functions =

Funiction Library
gl 4.30 §sAot WS

2ol 4911 Bectis vey GUAL( Al 5ot ol Aot GUAdLl el A B.
ABS WA oletR bRl 8lad Al dot (SHA AU B.
AND ol otll w0 Aoe AAL flat Al ALY AU B oAldcAR WIg W B,
AVERAGE 31932 (QreHl U ololRle] RRA ual Guall 8.

CHAR W] o2 Ml UAA 515 ololRall 352 WA B,

CODE W] o2 Ml U B0l 815 W B,

COUNT  ogfRee (AreHi dectl ook ® A g2ld B.
COUNTIF  AlssU 2Rl Al lat dal ¥ectl Ad ® A g2a B.

DATE YN HL AUAA ARl 1 eI 1900l sH ol B,

EXACT A AWRL ARUL B 3 ol(d A el W2 duRlA B,

EXP WAUALS e (2.71828182845904)0ll WUA ololR Fcll Uld MUl HER cduRjA B.
FACT WA oleell st Ul U 8.

IF dAlls yBa sral 1 Gualloll .

LEFT WY N UL AU 2sr2oll ATuLALl Rl weRl Yl wsal GuAa(l 8.
LEN U Ao HL AUUA AGENHL F2ell AR B A glal H2 GuA(l B,

MAX UYNo2 (Aol WA olatAuiell HedH ucl GuA( .

MID U Ao Hi AUAA 2520l clRAYL Al et el wsal GuAd(l B,
MIN WY Ao2 (Aol WA olotAM Ay Wual GuA(l B.

MOD As ololRal oflost ol ad aldldl 3ecll AN all A uct GuAoll 8.
NOW slctoll Rl Aol AHA gallacl GuAll 8.

PI UAUNLS T (3.14159) ofl (Bud eala ®.

PROPER  logfAloeHl AU cllsioll €35 2seall YuM AR 3ect ua B.

RAND 0 Ul 1 AR SH ololR WA B.

RIGHT URAeHL AUAA 25201l Al ATl el el wsal GuAd(l 8.

ROUND 8l clolal Assy e2lial Qe usloll 2is Yl oldiaal Gualoll 8.

SQRT 818 ololRe] cdlym ual 12 Guad(l 8.

SUM N2 [AreHl WA o6l YA 5l AURLA B.
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SUMIF UYNo2 (AUl AUAA oletA Higll AWssA ARA AR fla Acl dletAal U 5l
duRAA 8.

TODAY gl Atdlu eselel GuAd( 8.

UPPER 25l WUR 3 / 3ecdl $Raal HI2 durlal B,

LOWER 22 lRAR SUHL ¥clal HI2 duRllL ®.

20l 4.9 ¥2clls Guo(l §salote(l ALl
oS $59ol SHLoS

Boe §520t sHloS{l Heedl N Sl g52at ALl AL Ol AUx 520l U2 AUYNoe URlE 3 28
8. 8o §52ol SHloSell GUAL sl HIZell AUl o{lA Yo 8.

- 2
Insert Function :

Search for a ﬁJWS&%M o] ollH Al GO oleat golldll
sUMm ry Go

Or select a cateqory: |Remmmended

Select a function:

SUMIFS

SUMIF

LIMEST

SUMX2PY2

SUMX MY 2

SUMPRODUCT -

SUM(numberl,numberz,...
Adds all the numbers in a range \of cells.

Qzeuiell $520t RAS2 83U
Ul OK 0l2al Eollell

Help on this function | QK | | Cancel

AULg(A 4.31 BoU& §52Aat SLAALL GllsU

o ¥ AUl 5520l Aulclle] Sl A Ad RAse 5A

o A 30Ul £AAA Boe §520l 5US Eollclcdl WIs(A 4.31 Yyololl Boré §52Uot SIAAL U
WA ® Bol Heedl R §52olo] ol 28U 53| Go wesl eulldcdl A olldeld] AUl Aol Bl
ollH YRleldl §52lotq] (ARe 21 B.
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o [Areuidll $520t RAse sl olle OK el golleldl A §52ot M2 %33 Rz Norclall HI2
UL5lA 4.32 Yosololl R Ne2 SIAALL Glls WA & BUL §59let YHIAL w0PAo2 GlEALA B.
o AR abelleuidll RAAse MUl A 21U 531 OK oleat gollaldl A §52lot Al A

AULES o2l B.
Function Arguments ?
5UM
Numberl C5:C7 FR:| = {56;96;87}
Mumber 2 | =

RO scll 3% RAse 53 Ul A Al

= 2335 <«—=ARAOU ol ¥cllol
Adds all the numbers in a range of cells.

Numberl: numberi,number?,... are 1to 255 numbers to sum, Logical values and text
are ignored in cells, induded if typed as arguments,

Formula result = 239

Help on this function Cancel

ALg(A 4.32 WA sLAALL olls

Adtdl woul ustAl

1. Al 4.28 Yool AsAA 22 slotlcll 5ot 1S wal 251 Sl Wl §52lotoll Heedl N
2. €35 [AMAML AYdH AR HedH HIs A

2.5 aballe, QA sldd U Ac WA s 8

dA s AsAA 2010 A3 $A AR A As wWidl abojs % 52 & Bul ol aselle wadl sa
8. i oA decll abelle GARl waudl g (Delete) 53 ASL AM Aol aboysoll vieR Al sl O
AU Aol $H 38R, olsc wUdl WASL UL ASL Bl dguid asallea Yu wa walu 3| AslA ©
Al A A Sl o gl 53 AstA B Bl WA 5l A URL Al K\ AsLA B,
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dR A AR Sl GRIL Aal £2 ASL B Aol AS]l wal 2utsl s 61, Aol QRUE U udloues secll
sl ol

otcl adalle ael Alad BRI astA B (Insert)

1. sl 4.3ul eallcal Yool soé aballe sleot ealadl As ocl adalle GRRAA B.

2. sl 431l eallcal Yool olle 2t UR MIBAUe] wHQ weot (BAS scll Bullcl 2lése Nojuiell
8o [AsCU URE $cll Boré SIAAL s WA B BUl ¥t 2euiell adelle [@Qscu uie 3l
OK weat gallaldl As ol adelle GRRAAU B.

3. ShiftrF11 gollaldl Al 2lle udatl As ol adalle GRRA2U B.

aselle A A dlelle 53l asta ® (Delete)
1. ® le Sldlle sl fla Aot 2lle et UR MG WUR west (As sciugld 4.33 1l ealea

Yool 2llése Noj wUsl Al B BHE Delete URE sl A 2lle Sllle aa .
2. Home = Cell 2 Delete = Delete Sheet (5A5 5l W2 2lle Slclle aa .

o (Bl ol elleml el dlat A AsAc 2eal slclle sl Udal dua AHEA YD B.

asale of ottt A A wecll aslA ® (Rename)

1. % ablles] olld wecq dla Aotl e 2ot UR HMIBAe] w¥HY oleol (AS sl wsld 4334
gallcal Yool ése Aol WA B FHil Rename ([Ascu ude saell olleq] s RAse Uy s
8 RURULE old ollM 28U $3| Ao WUl ollH GLEAA .

2. ® asled] olld olecdd 8l Aol 22 2t UR sud GAs (BsU &l A aRk (ASs) sl 2leq] otn
RAse U8 A B RAURGUE old ollH 2leU 531 o2 WUAL ollH HEALA B,

aselle 201 ol 56R (el

asalleal w2 2leell Aol eallaal detl 2oiall &R olA gallcaul Yo wecl asia 8.

1. abelle 20l UR WG] WUY tleat (AS sctiugld 4.33 1 eallcal Yoyol 2lése Nof WA B BHl
Tab Color [AscU URlE 53 B 562 5l 8l Aol UR (5AS $cll 2uloll SHUR HECAU B.
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15 Insert...

16 @ Delete
L Rename
18
19 Move or Copy... Theme Colors
& View Code H EEENEN

20
21 (&g Protect Sheet...
5 | [ [ {11111
23 Hide
24 N Standard Colors

- L] EEEEER
25

Select All Sheets D No Color

W 4 » | Sheetl | Sheetr —smees
Ready |

%% More Colors...

gl 4.33 2lle 2u AWese Aoy

ablleoll sH dedd WAl aisA 5l (Move or Copy)

Al adallea Assu sHHL o6l sl Ol wacl Aol atset uel 531 sl L.

® asalle WA ¥ slUl scll dla A abelle 2o UR MBUo] WM wesl (A scll wug(d 4331l
gallcal Yool 2Wése Noj WA & BUL Move or Copy... [AscU Ue scl gl 4.34u0 ealc
yosololl SlAALL st WA B Roll Heedl RAse adle 58 asysui, s¢8 olle udatl, WA B 3
Sl 5l ® A otssl 31 Asla B. OK weat eolladl uredll Harol 3812wl 8.

Move or Copy ?

Move selected sheets  g¢5 545 i olle GRRC ®
To book:

Book1 W

Before sheet:

Sheet?
Sheet3
(move to end)

585 olle i RAse sdcll Ale GRRCA B?

[ Icreateacopy <+ — ol AUl s2al As 53
conc

L[ 4.34 Move or Copy SLACL GllsU

adolle dtscll 3 tuwiscl (Hide or UnHide)

B xR aballe ollstal ot slcdiacl 8lct Al AR Aol Acltsl URL A5 Ol Wal %32 USA dal Uel 2usl
ugl A8l 8l B ablleal Aciscll la A adlle 261 UR MBU WUY wesl (AS sl sl 4.334l
gallcal Yool Aese Nof WA B BHl Hide [AscU Urie sl A 2lle Buidl «tel.
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Al 2lleal wedl Buusal w2 asalle 2ot UR HIGUe] ¥HY weot ((As scdl dugld 4.33ul
gallcaul Yool 2lése Aof WA B BUl Unhide [Ascu Ude scdl R Hide sl 2lled] (A2 e2ladl
sl cllsy WA B adiell @ 2lle Buwiscll slat A urle 531 OK wUAL A 831 Ewa B .

As cAfols ofl WAL UL abglle ol As sl ay (AosSl Ui %1l

Asell ay abelle As WA Blal W2 dR adoysoll otcll [AosSl slottcll 25 Ol 2L MR View D Window
> New Window $cll A% cb¢soll olcll (AoSl WA B. RURGUE View & Window 2 Arrange All $cll
uls(A 4.35 Yorololl SIAALL s WA B Bofl Heedl s & dsusell A [QoSla ALElel BH (Tiled)
WSl (Horizontal), Glell (Vertical), DL WA (Cascade) AR Il e Al &l usld 4.36 i
Vertical (Qscu olle As abofsell A (Aodl WAL AL abelle slcdld .

Arrange Windows ?

Arrange
() Tiled

[ ] windows of active workbook

Aus(d 4.35 Arrange Windows SLAGIL clls

HE9-v-QRF- Microsoft Excel - g
m_ Home  Inset  Pagelayout  Formulas  Data  Review | View | Acrobat  Team s @
= = _— e [ 1, Esplit |11 View Side by Side = % =
u E |—| (IJ |—G| o Fomu sar A _E‘ E E = Hide 237 Synchronous Serolling = Zﬂﬁ
o ot “resew | Uina: Sreen | [ Crdines [ Headings | Zoam 100% SRS | edow AN panes~ [ Unhide | B Resct Window Position | orkspace Windows« | -
Workbook Views Show Zoom Window Macros
I c2 - £ | =B27sES2 v
) Final-1:1 o B = Final-1:2
A B C D E ] | A B c D E F G H 1
1 : 5 W23 Buld 3 . e |
2 ey 53.98| 145.746| 2.70| [ 1,245.07 | T 113.30 2 B
3 AgfRan 58.39 % 1,259.24 3 ke wsl: wsla sa wb es sl ulRoum
4 AcyMl=lan 46.95 % 1,584.12 4 56 96 87 239
5 Aecyl=lan 29.98] % 1,131.61 5 65 66 55
6 uleyliEan 51.28] % 1,024.51 6 85 33 66
7 eyl 39.53 % 1,081.14 7 96 55 65
8 Acyl=lan 64.81] % 1,557.29 8 66 22 a8
9 Aeyl=lan 47.07| % 1,386.97 9 78 4 59
10 BeylEan 56.00] % 1,296.85 10 58 55 67
11 HeyflEan 68.16] % 1,431.24 = 1 78 66 63
12 WeylEan 42.89 % 1,623.80 12 58 98 58
13 weylEan 51.46] % 1,055.25 13 87 78 95
14 WeymlEan 89.78)] % 1,576.79 14
15 15
16 wledleye A 2yeed wa? sl 543 @u weald ol 16
17 %wRll? 5z AC 25204 uR B2 @R Fa Euleldl o wly cls s wa B 17
18 18
19 19 1
20 20
21 2
2 Bl =2
23 <2
4 4 ¥ M| Inroduction - Cell Basics d PasteSpecial ~ M4 m ] » [].| | [ 4 » W[ Inroduction .~ Cell Basics .~ KeyBoards .~ Paste Special .~ Number Format_|_Simple Formula .~ Abs|
Ready | |[Emm@m 1o &) L] (+)

ULl 4.36 As o adoysell A Wetdl wUadL adelle A (QAeSHi Gell ANsarl
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s abale oll el YEL GUON WS AU WEAIL WAIL Vot Ui Alall

View 2 Window = Freeze Panes $cll ls(d 4.37u0 ealcal Yol AsAc dsoisal As2a Actoll
GuRel AR ol adAl & B Axey 5l As UL BlA sl oflost eoL sRal w8,
AR %32l Sl U View & Window = Unfreeze Panes $cll 0ol ab2lle gullal ©.

EH9-¢-0DBREF- Final-1 - Microsoft Excel - g
m Home  Insert  Pagelayout  Formulas  Data  Review | View | Acobat  Team o @ o @ =
f = 5 N e [ 5 i EIsplit | [¥]View Side by Side =
D S D E gre @rmes ] = 5EE L mFE R
Normal| Page Page Break Custom Full | (7] Gridlines (7] Headings Zoom 100% Zoomto  Mew Amange |Freeze I ave Switch | Macros
layout Preview  Views Sereen Selection | Window Al |Panes »| ] Unhide | 514 Reset Window Position | warkspace Windows =
Workbook Views Show Zoom T = Macros
wm - & e -
Freeze Top R 4 -
. A [ C ; E 3 G H 1 [ x | i mpm;”m I AD AE AF AG AH Al
through the rest of the worksheet, A
2 zsorufHlellez [yd ydloy 61) % 5,000.00 | 610.00 | *Filter wi Freeze First Column E
3 10-01-11|[Ue? yd PR (E) 65/%  1,755.00] T 942.50 Keep the first column visible while scralling
a 06.0111 [ﬂaﬁ? \J\CI E:R"t{ 54| < 1,728.00 T 928.00 through the rest of the worksheet,
5 oant1|feee  [yd alldx 53/T  1,701.00] T 913.50
6 17-0111|le2z  [udW  [sicopet 652] T 1,674.00 | < 299.00
7 aroen|leer [Gaz [Bud 513 1,647.00 | < 884.50
8 2101112z [ulEd [Bad 58X 1,566.00 | X 241.00
9 2sor-m|fe22  [eellol  [olldm 56/ 1,512.00 | < 812.00
10 210011|feez [yd ollan 56/%_ 1,512.00| X 812.00
11 10-01-11f20L Ay [udle 533 1,449.00] T 693.00
12 os5-0111f2e yd 5169t 50/ T 1,220.00 | T 660.00
13| 20-01-1120L WAy [Baa 59(%  1,357.00 | X 649.00 |
14 1s-oti|dleide [ullu [sllan 53T 1,323.00 | 582.75
15| 1ror1ifflesr  Juln  [ael2 293 1,323.00 | X 710.50
16 28-01-11|dleuda [yd ELh 62|%  1,302.00 | ¥ 573.50
17 1sor1dlellez [uEx  [udla 593 1,298.00 | T 590.00
18 o7-01-11[dleude [yd ycllal 51/T 1,281.00] T 564.25
19 13-0111fdldlez [BdR ydlol 57|%  1,254.00 | X 570.00
20 16-01-11)lolle? [GaR Hew 56/ 1,232.00 | < 560.00
21 1s-01-11ed cellol Juellz 533 1,219.00| < 583.00
2 onfdel [Bd2 [ul? 54] 3 1,216.00 | < 512.00
23 os-or-u|Hlede [eallal [udla 57|% 1,197.00| X 527.25
24 13-01-11[201 cellol [adlz 52| 1,196.00 | X 572.00
25 230111 Uee?  [uEM  [slcojst 44]%1,188.00 | X 638.00 5
M A rH Pasct:e Special -ndmber Format .~ Simple Formulz Absolute Reference Sale-Jan . Sale-Feb Sort | Filter . Sparkline /%2 1« [ wm__  I»
Ready | |[E|E E 100% (=) y] (+)

g(A 4.37 Freeze Panes (Ascu
dAHdl yould usiA

ASAAHL SLTA ool Aol Myworksheet ollA Act $3.

AsAAHL atcll 2lle GRRA Wal Aol Mysheet ollH AU A Aoll 204 SR @2 53U,

Mysheet o hide $30 Wal RARGMLE dal unhide $3.

¢
2
3. Mysheet a4 Yy 2le R WASL Aal Aoll SIUl Mysheet-1 313 532
4

A al SlAM WA 814 8

AsAAHL dA As Actoll WAL, 2l A waar well Sted GAZL Axe g2 531 a8l 61, A Wa
SletHal ActSl wal utest 2usl a8l 91, Aofl GLUE wal SletHell udloues olecll sl .
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A wWal sIAHH GRRal

AsAAHL A ol SleHoll Avaul WIUB WUl Yool AlssA B Ll AR X A GAA AR olislell
A oA WA B U Becll A g2 AA B AHY SIAH GRRl wlislotl sleAH sHRl ety WA B. A decll
A/slemil 1R 8l Al dA A/stdd GAZ asdl otell.

acl A A A GRA asia B.

1. % Actell GUR A GRRl 8l Asll A oleR UR HIBUo] WHY vlal (AS scll 2Wese Nof WA B
BUL B [AsEU URLE 5l A GARA B.

2. Home = Celis = Insert = Insert Sheet Row $2cll A2l Actell GUR As A GARAAU B

ol sl A 3l GAR asta 8.

1. % Actell stell ol sl GARC Sl doll SIAH AR UR HIGUo] WHY sleol (A sl s
Nof WA B BUl B ([AscU UE 5cll A slemoll stoll iy As sl GRRAU B,

2. Home = Cells 2 Insert < Insert Sheet Column 5cll Alsecl Aol stoll ol As sl GRRAA

‘ CS)

A Aol Sl £ sRcll

% A wUcl SlAAHoll %32 ol Sla Aal g2 53 AstA B. A A ¥ slad gl Slelle us s Al dal
Ctri+Z ¢l Wl undo sHLesl Wedl cucll asia ®.

A A da slcdle 53 asta ®

1. ® A slelle scll 8l Aotl A oletx UR HIBU] YUY weol (A5 scll Aese Aol WA & FHl
Delete (AsCU UdE $cll A A £ A B.

2. Home 9 Cells D Delete>Delete Sheet Row $2cll AE2cl Actoll A Slclle a B.

sl & Al Slelle 53 asia 8

1. % sl slclle scl 8l Aol sl weR UR HIBUo] WHR vleat (A5 scll 2lese Ao WA B
BUl Delete (ASCU UAE 5cll A SlAAM g A .

2. Home = Cells P Delete=>Delete Sheet Column $cll A2l Actell slan Slelle aa 8.
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A % sled Adlsal ¥ gulsal

A/SAHA Acdlsal A RAse s3] WBUe] ¥HY weol (A5 5l Wese Noj WA B Ul Hide (Ascu
UAE 5cll A A/SIAH a2 A B.

A/l $31 Butsal dsll eyoiegell A/sld RAs2 531 Aol UR MBUe] WHR vleat (5AS 52l
liése Nof WA B BHL Unhide (AscU e scll A A/slAH Wl 2w .

SlAHo{l USloUE A Aol GLRUES cectcll

slettell UBlouE WSoeHl HiuaHl wa B. yaeld A, e3s sledell uslous 64 LsAL (PX)
wcll 8.43 WEoe AUsH B2l sl 8.

o{lA ealacd slsunl I sicHe(l udloues oedl asta 8.

1. HIGU WBe2R sleHoll 1Rl ologell cll§2 uR Av{l + U JOU (SLof waat gottcll Wadl) 3.

2. Home =» Cell & Format = Column Width UE 53| SIAAL GlsUHL USloUe .

3. Home = Cell & Format = Autofit Column Width AUcll SlciHe(l udlousS el ctiolt cwiel
gl aa .

4. SlAHoll MRl oltgell o§R UR sHA (BAS sl UMY A SletHoll udlousS Well died dvial
gl aa .

1A ealdcdt Sleurt A Aol QU aecll asia .

G WBo2R Sl o{lAsll 82 uR 2Aull +ma 9L (st¢f vteet goltell Wudl) s2A.

2. Home = Cell & Format =»RowHeight W€ 53| StAAL clsuHl usloue .

3. Home =» Cell & Format = Autofit Row Height ¥Ucll SlcHe{l udloues Aell ciott vl g2cll
aA 8.

4. sldMell wuell oegell oll§2 UR sud (BASs scdl WU A Sl udlouss Al cioll vl

gl aa .

—

Ada Sl wa Ve 52l

B Adal sl s2cll la Al WU AUl ARA Sloll Heedll (A AA 50U Wl At 3%) RAAse
5. AdA o{lA eladcdt Icaniell styuat As A sidl .
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e Ctrl+C goildl.
o RAs2 53 A UR HIBU] wMY oleal (5As 53| Copy ([Ascu Urie s3.
e Home =» Clipbaord = Copy Qs 53

Ul A WSl dlal Ul oA elad 51¢5 Ul As 3lA Wre 532A.

e Ctrl+V gollcl.

e RAs2 53¢ A UR HIGBU] ¥HY vleol (5As 53| Paste ([Ascu Urie 53

e Home = Clipbaord = Paste Hi2l (Ascu ude 531 Aol UR (5As 53, AsAA W 5l UdAl
dHal A 3d EWld d ugl wcdld 8.

e Home = Clipbaord = Paste (5As 53, WSAA cdHal W2 scll M2 YEL el (AscunA B, R
oA Yol .

Paste Actoll wdcl, e, wa 32t AA2et Vre sRcll.
Formulas SlRfcll Ve B ud 2L o8l

Formula & Number g5t Sl ol oloir U0l Vel B.
Formatting

Keep Source Formating f:sh?gc'tl Ul wy SUEloL Nee ala 8.

No Borders W82 Rale] vy A Al .

Keep Source Column Width  $l2jcll wal %l 1l 52 8l A sletmsll usloue snas 8.
Transpose A A SlAH WA Sl A A soll 2 B.

Values oL Actell HBA o W2 B.

Values & Number Actoll HBA u olotr SEl0L o e ald B.
Formating

Values & Source Formating  Acto{l UGl ua oy SlElol Wee Al &

Formating g5 SISl Wre a2 B.

Paste Link SIl sval Act Bl o et WA ® AR «1él

Picture HRAA R A3 A 52 B.

Linked Picture HEAA R d¥ W 53 B Ug sl s Ad ceddl @A uwl
WEAA B,

20l 4.10 W2 HI2all [Aseu
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Aol WAS AL

AdA HASAL HIZ AdA RASe 5 RURoIE A 52 531 e 5l WASL aslal B wual RAse
$¥CAL Ada HIGUUL 3oL 53l Ul WASL st B, tulotHl AW ¥ URL wAR A WASIA ¢l
IR % Al AWRL 8l dl A oAU s B ol otq cvtgl vl s 8.

AA 51N

Actoll cvttel QA auRiell HBA wual W2 SlReeall GUADL Al B. SlNoe AUl HIZ A YauH
Ada RAse 53| {lAniedl slsurt As A 2l st ®.

e Review = Comments = New Comment Ule scuell

o At UR HGA Avl wHQl (A5 sl 2Wése Ao WA B BHl Insert Comment ([Ascu ure sauel
o Shift+F2 galtacuell

RUIRULE 5Ace 218U 531 Al asta .5l 4.39 Ad UR HIGU WSeR d8 »di tuldl slRee
gold ®.

Microsoft Excel - Book1 - [
B2 - .fr| Interest g

A | B C D E |

1 -« THIMANSHU: Simple %

2 Interest Rate 1 Interest

3 10%

a

5

ﬁ -

4 4 » M| Sheetl .~ Sheetz ."Shdl4 M v [l

AUg(d 4.39 Act sl

AsAAHL SlAo2 ol £ sRcll U2 Review & Comments 2 Delete (AscUsll GUADL AU B AMe
$l0o2al Acllsall AUl EWLscl Review =& Comments & Show/Hide Comments oll GUL Al .

2.6 2old 81{2 (Table Format)

32l 3o uR UdcUsl slH sl HIZ dA dal 2ecd Sle Hi ¥Rl A8l Ol B (A e2ldd GuABLl
A B

o WAl AUAA @I Yool iz s3] sl Q.

o 32lal WS A (3eeR sl & B,
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o A WA SlAH U dld3] udcussl 53| asl ol
o atscll (s0AF2) A DU £ 31 AslA O,
o 32lofl wSHUL udcusl 3512 53 sl B.

2ud olotlalall M2 A YUH B2l Adal 2oAHl ¥adl 8l Al RAAs2 5 RURGLE Insert & Tables
> Table $2cll Create Table SIAAL Glsd WA B. BHL OK ¢eot eolladl 2ud ololl oA B Aol
UL5(A 4.40U0 clctlcal YHIB Retot UR Table Tools & Design 26 WA B.

Formulas Data Review View Acrobat Team Design

e 'j HeaderRow [0 First Column | [Soj==s) ppep e | B =] -
o= I T e = e E===5|=====|Z=2=== —————- === Z====
[0 totalRow [ tastCoumn | |[E==== E==—=|l=====l|Ec===| =====| [E==== ===== -
===
E===-

Export Refresh . _ ===
S - Banded Rows [[]] Banded Columns

External Table Data Table Style Options Table Styles

AULg(A 4.40 2act Baget 2ul

2ud Bolget 2ol RS Yu wgld 4.414 el Yud 2oictall vl aectal MRel Yyl
WA B, wAR 261A [338el 2L 2HA RASA AWt YU A5l 4.41H0 ealcal YA dMa &5
A (Header Row), 212l A (Total Row), YUH SlAM (First Column), A SIAM (Last Column),
Aods A (Banded Row) ol AlodS SIAMHal (Banded Column) EUMLScl/GlEA Bl [Aseu w B.

yaH sldu wiAn ls‘lau
A B C D

1 Al g dAR g  tA g U R
2 oclel |Z¥ 3,255.00| USA 2
3 Qe [T 4,865.00| USA 4
4 UM [T 9,339.00 UK 2
5 oclel | Z 14,808.00| USA 4
6 ol$l4 [T 1390.00| uUsA 3 Acds 3
7 Qe |2 7,433.00 UK 1 ;
8 Qe [T 9,213.00] uUsA 4
9  oisld [T 969800 USA 1 et A e uwd B
10, ¥k |Z16753.00] UK 3 2 oL el olecll a5l
11 ddls  [Z 18919.00| UsA 3 3
12 uelR | 10,644.00 UK 2
13 ad{la | T 12,438.00 UK 1
14 % clol Z 14,867.00 USA 3 ugldl 2oictell
15 [Qea | % 19,302.00 UK 4 / A2 olecl sl
16 Total 37 ¥ | B

Al 4.41 2act Sle
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zolciell gucllde A A Al dal g sall usld 4.40Hl e2lcal YHIA Remove Duplicates (Ascu
ude 83l asia ® % wsld 4.42u0 ealcal Yyl slAAL st olcdld B FHL B slanHial
sucllde A g2 scl dla A ude 531 OK JUAL 2AUAML 3812 L B.

352 A 32lal W U (e sal H2all [Ascu A B, A U (3ee (AN wud A ugdlal yeiui
(Qatd AUy, 2ac sde g2 531 Jelal AHRA A Iwul 3ctcl wslQ 4.40ul galcaul Yyl
Convert to Range ([Ascu urle sl asta ®.

- I
Remove Duplicates :

To delete duplicate values, select one or more columns that contain duplicates.

§§ Select Al E = Lnselect Al My data has headers

Columnsz
]
=]
gl
=l

K Cancel

Ag(A 4.42 Remove Duplicates SIAGL 6lls

2.7 d2laL (Sorting)

AEDL dHa 32lotl sHA (UBCAL ¥ GcRcll) Gledall Ul ¥3RAU YHIB AL scllofl YlAul A
8. ALl Heedl 3atal HouaRlell sHML, Aissisla sHML, ARl uUA UH2A A dAHEL uried(lstl
sl ollscll astal 8. WD R As sl AR ARML delal A 531 Al 8l eld. AR
s AR AL 32l yaun (Aelol Yol RURGIE ol Yol RAURGIUE GHR Yool dllscll sl &l sweH
AEHHE dN dHRl @ Yool 3eta W 531 ASl 6l el (Distinction, First Class, Second Class,
Pass, Fail).

$2l A As sldM UR M sl B SlAH YHIB AW sl 8l AMl sleugl Adt RAse 53l «{Auiadl
sleuel As Ad Ae 53| asia B.

1. Home =» Editing =»Sort & Filter =»Sort Smallest to Largest/Sort Largest to Smallest
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|

sl %
2. Data =» Sort & Filter = % or

32l As $cll AR SlAH UR AE sd, slsurl As Ad RAse 53 «[Aniell slual As A W
53l asla .

1. Home =» Editing =» Sort & Filter =»Custom Sorting

|

AlZ

=

2. Data = Sort & Filter »Sort 29

GuRHiel 818 As (Ascu ude sl wWslA 4.43 Yool A slAALL Wlsd WA & Auey AsSAA
wul 32l AWAU RAse 52 B. RAURGIE %3RAA Yol SldH Ay AE s UAE 53 Add Level
olaal gnlleldl SlAM A Uy oA B,

Sort ?

”’;1 Add Level >( Delete Level 23 Copy Level & || w || DOptions... My data has headers

Column Sort On Order

Sortby | aun w | | Values v [AtoZ W
Thenby |z w | | Values w  Smallest to Largest 1™
Thenby |-z w | |values w | |Smallest to Largest ¥
Thenby |mzed-z w | | Values w | |Smallest to Largest W
Thenby | ge sl w | |Values w | |Smallest to Largest w
Then by | ulFoun w| |Values w | [AtoZ w

AUlg(A 4.43 AE stACALL s

2.8 (3ceR (Filter)

(3ceR AWssA 2RAl AdA™MAl da Adl o A 2wud 8. wH (30U GUAL Jalal yalsal Axey
wollell Sl gallacl U (@Aot33 32l uldaloll YAul AU B, A As sl auR (eer
Ao WSl 28l Ol AMe %32 ol Slad R (3eera g2 531 alul 3atal BuA 531 Asl 6l dA 3ala uis,
AR, 20E ¥ 201 YHIAl el (3ceR s3l asl ¥l ® 32l (3R sal dlal Axl slsuel Ad RAse
530 ol AMie sleunl As I (e Ul astal B9 WoUB (3eeR WAA slal Al d g2 Al B.
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1. Home =» Editing =» Sort & Filter =» Filter
2. Data =»Sort & Filter =»Filter

wlsld 4.44 32l A (3ceR sall udal wal wislQ 4.45 Hi delat (3eer salole A (ol (3ee: Hi2sll
olst wlcl i ® A e2ldd B. ollst UR (AS scdl dUslA 4.46 Hi £2lcal YA AHL A SlAMsll
32lal A sclloll AH wl (Select All) 3 AssU 32l Blal Hizell YAul Wt B,

| A g C A B C
1 | RollNo | Name |[Date of Join 1 | RollN ~ | Name ~ |Date of Jo ~
2 1 Jatan | 01-05-2001 2 1 Jatan | 01-05-2001
3 2 Sanjay | 06-08-2003 3 2 Sanjay | 06-08-2003
4 3 Kiran | 07-05-2007 4 3 Kiran | 07-05-2007
5 - Savan | 09-01-2002 3 4 Savan | 09-01-2002
6 5 Nisarg | 05-06-2003 6 5 Nisarg | 05-06-2003
| 6 Flaguni | 02-03-2002 7 6 Flaguni | 02-03-2002
8 7 Anal | 01-05-2001 8 7 Anal | 01-05-2001
<) 8 Devyani | 06-08-2003 9 8 Devyani | 06-08-2003
10] 9 Ajit | 07-05-2007 10| 9 Ajit | 07-05-2007
11| 10 | Mitesh | 09-01-2002 11| 10 | Mitesh | 09-01-2002
ALg(A 4.44 (3R ran udal uglA 4.45 (3ce2 RAse sl oue

A B C D E F G

1 Rl}llNlZl Mame ~ | Date of Jo ~
‘—El Sort Smallest to Largest

il Sort Largest to Smallest

Sort by Color 4
L
Mumber Filters » Equals...
Search 0 Dioes Mot Equal...
[ (Select All) ” Greater Than..,
M1 Greater Than Or Equal To...
w2
v 3 Less Than...
[ 4 Less Than Or Egual To...
5
----6 Between...
-7 Top 10..
- la
....g " Above Average
Falan Below Average
oK Cancel Custom Filter...

AUlg(A 4.46 oo (3ee?
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(G A < | A B C
- 1 RollN-T| Name¢ - |Dateoflc ~
B 2 Sanjay | 06-08-2003
4 3 Kiran 07-05-2007
Cance 5 4 Savan | 09-01-2002
5[ 4.47 Bea 2 32t wudl 6 5 Nisarg | 05-06-2003
7 ] Flaguni | 02-03-2002
a8 7 Anal 01-05-2001

Ag(A 4.48 (eer 2 3at
32loll Yslk YHIQ AAA (ololR, 32 ¥ 25e2) (3ce eald ® wusld 46Mi Roll No. M2 ololR (¥ce?
UAld B Boll UR 818 [Ascu ude scll gl 4.47H1 e20cal Y@l slacldl s WA & BHl
%33 2Rl elHc 531 OK olael eallaldl dal (3eeR ala B. (3eer udd dat wsl 4.48Hi e2iad B.

A3l youl@ ustAl

p

1. A 4.41 Yol AsAA 22 olottcl Auiel ot sl Adle adl sla adl srellde dat g
53U,
2. 32lal olld ol ollH ARWL Sl l 22 YyHIdl Ae 5.

3. (Aotaietl 5000 ol aty QAL clon 32t 252 U oiolR (3eerell Heeedl eallcl 3.

2.9 Rl

‘/

Q1. Ao [@Aseu ude sA

1. ASAA-2010H ¥ AAML 32l EHA U A Ada 9 5& B?
A) Asdlad Ad B) RAse Act C) 522 A D) As Ul o1l

2. AWAsAA-2010H1 Sleuel AAHL o{lAsuniall sl Usirell dat elud 53l asla 8?2
A) uissl B) GWIAl C) SURjcll D) ALl Ll

3. AsAA-2010H1 o{lActtHiell s [Ascu et Ay slacldl dlsuHl Guated oiell?
A) Max value B) Type C) Step Value. D) Series In

4. ASAA-2010H1 ol Aol 52Ul U2 WIAAlsH YUH B?
A) * B) / c) -~ D) +

5. AsAA-2010 Hi AQAZRA scll HIZ g AUl sl B2
A)Sdl  B) §5%ct Cladalb D) HMAa
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Q2.

1.

v AW N

Q3.

10.

Q4.

(S I N VR N1

20 [@Aseu ad widl woa yA

ASAA-2010 Hi geoll BUAAL 53| AR dN Actell otscd 52A 6l wacl (3cd 5A
8l R oledldl ol (AeAeye, AAdla)

WSAA-2010H1 A% AAHL UHE S dal U sdclld 8§, RUEALS, JAUSU)
ASAA-2010HL 2l A RAse sal Hizoll Wése-$l ®. (Ctrl+Space, Shift+Space)
ASAA-2010H1 AL UL A5y A R auRla B, (WS, Sldn)

AsAA-2010HL §52lol oleAo] ARRAA Nuucll GUA( B (Average, Sum)

olAq] [Qtlet W B ¥ vllg A wuud

ASAA-2010H1 Actoll Avllal QA atuRlell HIRAL uucl HEE SlReeal GUalolL U ®
AsAA-2010H1 5L (,) &l 2l wdell unol Wl slcuul 3Racl Data = Data Tools
=>Remove Duplicates (AscUall GUL AU .

AsAA-2010 Ui Slsuel ysiRell oulllds ylsale] Assy uReur Andal M2 Goal Seek ([Aseu
AUl B.

ASAA-201041 Subtotal @scu 12 HIRA WE sl %33 otell

AWSAA-2010HL AsclR UL olofl o2 Ul Aol wctol Ul WAL aAstA 8.

Al 58t 1S

U o
A$?2 a.  yd cwval@d yA
$A2 b.  UA, UAA Aol ureRe(l Heedl AwiA .
§59lol c. AR sl sIUl s AR SlAH A olgl.
sljeu d. AssA ARA Al Slat Acll o A 2wl 8.
(3cez e. AR Ll slUl 520 R A Uecld otdl.

el

Q1
Q2
Q3
Q4

CCC-BAOU and CCC+

1-A (As3lal AA), 2-D (AUWLAll ®l) , 3-A (Max value), 4-C (), 5-C (a 3ol b)
1-AeA Y2, 2- RUSCALE, 3- Shift+Space, 4-UlES, 5-Average

1- W3, 2-WE, 3- W3, 4-ullg, 5-W3

1-c (AR sl s1Ul 5220 AR SIAH HEA oigl)

2-e (AR Sdcll 51Ul 5290 AR A HeAld «18l)

3-a (Yd catvulRd yA)

4-b (UM, AUA W A UreRe{l Heedl cdvia B)

5-d (AssA ARA Al dlat Acll o A 2wd B)
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